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AUSLOGICS CHILLMATE

Introducing
Auslogics ChillMate

Welcome to ChillMate! We're thrilled to have you on board. This manual will guide you through the features and functionalities
of ChillMate—your ultimate solution for preventing overheating, optimizing performance, and enhancing battery
consumption.

ChillMate’s cooling mechanisms are designed to keep your PC running at optimal temperatures, ensuring smooth and
uninterrupted performance. Whether you’re gaming, working, streaming, or just browsing, ChillMate adapts to your needs,
providing the perfect balance of cooling and efficiency.

But that’s not all—ChillMate also offers advanced performance optimization tools that fine-tune your PC’s operations, helping
you get the most out of your device. Additionally, ChillMate features battery management mechanisms that help extend your
laptop’s battery life, so you can stay productive and entertained for longer periods without needing to recharge.

Read this manual to discover how ChillMate can transform your PC experience, making it cooler, faster, and more efficient.



AUSLOGICS CHILLMATE

Auslogics ChillMate

ff == English (United States)
Welcome to ChillMate

Your PC's cooldown companion

Installation directory:
Auslogics\ChillMate
Create a desktop icon

Launch program at Windows startup ()

Send anonymous info to help improve our service (0

By installing this application you confirm that you have read, understood and fully accepted
the License Agreement and Privacy Policy.

v

Auslogics ChillMate

Installation Complete

Thank you for installing Auslogics ChillMate, the
ultimate tool to keep your hardware cool

Launch ChillMate
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AUSLOGICS CHILLMATE

Before installation, please make sure your computer meets the following minimum system requirements:

am Compatibility: am Requirements: B Download size: Recommended screen

Win 11, Win 10, Win 8/8.1, Win 7 300 MHz processor, 256 MB 46 MB of available hard disk resolution:
(32-bit or 64-bit) RAM, 50 MB HDD space space 1024%x768 or higher
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AUSLOGICS CHILLMATE

FEATURES OVERVIEW

Dashboard

After the launch, you will be taken to the Dashboard screen, where you can activate ChillMate, switch between profiles, view
your CPU model, and track key metrics live, such as CPU temperature and battery charge remaining.

In this tab, you can select any of the preset profiles to optimize your
PC'’s performance based on your needs:

Game Profile: Disables CPU optimization for gaming applications,
ensuring uninterrupted high performance while keeping other
optimizations active.

Office Profile: Optimizes system resources for productivity tasks,
balancing performance and efficiency for a smooth workflow.

Default Profile: Applies general optimizations with moderate settings
for everyday use, minimizing unnecessary Windows effects while
maintaining stability.

Outdoor Profile: Maximizes battery life for outdoor use, increasing
display brightness while enabling adaptive brightness to conserve
power.

Browsing Profile: Prioritizes light browser workloads by minimizing
background processes and throttling non-essential tasks, so you can
browse longer on a single charge without distractions.

Here, you can also click the gear icon to customize profiles, view your
CPU model and manufacturer, monitor its temperature, and check the
remaining battery charge.

File View Help

U @® Dashboard

O

Activated:

..Qﬁzas

f,

Profiles Statistics

Game Profile

Office Profile

Default Profile

Outdoor Profile

Browser Profile

2fr Auslogics ChillMate

Advanced Tools Ask a Question

intel.

13th Gen Intel(R) Core(TM) i9-13!

33°C.

Satisfied with the app?

Rate us!




AUSLOGICS CHILLMATE

FEATURES OVERVIEW

Top menu

The main program menu is located at the very top of the program window and gives you four drop-down lists of shortcuts to
almost every ChillMate feature.

The File menu lets you run apps, open
Windows Control Panel and other Windows
tools, access the program’s settings, check
for updates, or exit the app.

File View Help View Help Help

||]

1 Run Application 8- Switch to Light Mode User Guide

&b
i
@b

Windows Control Panel Company Website

B Dashboard

The View menu lets you switch between

Aumistaton Farl & Profiles Program Page color modes and quickly access each

- B e iy Free Auslogics Apps ChillMate tab.

125 Settings W Statistics *

= A &) Technical Support i i

® Check for Updates F) Advanced Toals Technical Suppor The Help menu.prowdes ev'erythlng you

- need to get assistance, register the

Ask a Question 4 Send Feedback program, request a refund, or learn more
|":"-.|.15|':";§i|:5 Ctore -I"'_'I- Send E,|_1;:| Fif.Ef:!--::-l't abOUt Ch'”Mate and other AUS|Og|CS appS

R ——
(&) Request Refund

(i) About
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AUSLOGICS CHILLMATE

FEATURES OVERVIEW

Bottom panel

Below the main window, you can monitor the most important parameters of your PC.

CPU: & 31°C @ 8% GPU: 8 33°C @ 12% RAM: @ 36% View more

CPU shows your processor’s current temperature and load, GPU shows the same metrics for your graphics card, RAM displays memory usage in real time.
The View more button opens the Statistics tab with additional metrics. Clicking on the gear icon opens Settings, the arrows icon lets you check for and install
updates, and the Activate Full Version button lets you purchase and activate the full version.
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AUSLOGICS CHILLMATE

FEATURES OVERVIEW

Right-side panel

The right-side panel displays your CPU’s make and model, current temperature, and battery status. It also lets you rate the
app and provides quick access to the Auslogics Store tab.

intel.

13th Gen Intel(R) Core(TM) i9-13900K

33°C o
N\J 2 h 35 min time

remaining

e

“ P

Satisfied with the app?

Rate us! Auslogics store

The upper section gives you an overview of your PC and CPU make and model,
including the manufacturer and generation.

This section displays your CPU’s current temperature and its temperature trend.

This section shows the current state of your battery, including its charge percentage
and estimated operating time left.

The Rate us link lets you rate ChillMate on Trustpilot if you like the app.
¢ Clicking on Auslogics Store lets you access more useful software from Auslogics,

review information on each program, and download installers. Full versions of the
recommended programs may require license purchase.
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AUSLOGICS CHILLMATE

FEATURES OVERVIEW

Profiles

In this tab, you can activate and
customize ChillMate profiles, which
were outlined earlier in this manual.
Customization options include display
brightness, CPU power throttle and
core parking, Windows effects and
extra features, and more.

File View Help ‘rﬂr Auslogics ChillMate @ U _

[« ] Dashboard é Profiles Statistics Advanced Tools Ask a Question Auslogics Store 2

~ Game Profile

Display Brightness () Installed Games

Checked games will be run with the full performance. When you run these games, the
application will turn off optimization during a game activity.

Blue Color Filter ()

¥4 Fallout 4

Windows Effects (7

#7 Forza Horizon 4

i (7) ¥) ¢§R Grand Theft Auto V m
Windows Extra Features () 9 @ -

“‘? State of Decay 2 Manually added

Switch my laptop to Sleep Mode

Never
Scan games + Add a game manually

Switch off a screen of my laptop

CPU: & 41°C @36% GPU: & 33°C @ 12%  RAM: @ 36% View more

o @)




11

AUSLOGICS CHILLMATE

FEATURES OVERVIEW

Statistics

In this tab, you can view your CPU load
and temperature, as well as your
battery status, for the past 10 or 30
minutes or for the past 1, 6, 12, or 24
hours. Below the graph, you can also
see the total time that ChillMate
optimization has been enabled, along
with current CPU temperature, CPU
load, and battery charge.

File View Help

[« ] Dashboard

3:06:23

Optimization time

# Show CPU load

CPU: { 68°C @ 36%

Profiles

68 °C

CPU Temperature

GPU: §§ 33°C @ 12%

) Statistics

92 %

CPU Load

# Show CPU temperature

)
{
(=]

ffr Auslogics ChillMate

Advanced Tools Ask a Question

56 % 3309 RPM

Battery charge CPU Fan

§ Show battery status

# cPu load: 92%
. CPU temperature: 68%
. Battery charge: 62%

RAM: @ 36%

NET: @ 61.2 Kbps

ki—b

SSD: § 27°C (@ 2% View more

Q¢ -

Auslogics Store 2

Need more data?
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AUSLOGICS CHILLMATE

FEATURES OVERVIEW

Advanced Tools

In this tab, you can access and enable
or disable tools such as Processor
Optimization, which ensures optimal
resource allocation; Disk Priority
Manager, which allows you to prioritize
the programs you are currently working
with; Desktop Protection, which
prevents Windows Explorer and
Desktop Explorer from crashing; and
Memory Optimization, which speeds
up application launching by improving
memory allocation. The Memory
Optimization tool is only available in
the full version of ChillMate.

File View Help

[« ] Dashboard Profiles

Processor Optimization m

Disk Priority Manager

Desctop Protection m

Memory Optimization m

CPU: 8§ 31°C @ 8% GPU: & 33°C @ 12%

r“'f Auslogics ChillMate

Statistics r" Advanced Tools Ask a Question

Advanced processor optimization

This tool monitors the list of running processes and ensures optimal resource allocation. This promotes

the most effective processor usage and speeds up the system and applications.

CPU load: (8%)

Process name Application name

explorer.exe Windows Explorer 10.0.22621.2428
Integrator.exe BoostSpeed 13.x
Skype.exe Skype 8.110

Lightshot.exe Lightshot 5.5.0.4

RAM: @ 36% View more

Q¢ -

Auslogics Store 2
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AUSLOGICS CHILLMATE

FEATURES OVERVIEW

Ask a Question

In this tab, you can contact our
computer experts for professional
answers regarding Auslogics products,
Windows, PCs, software, or devices.
You can also check if your question has
already been answered by clicking
Read other questions under Latest
Question in the right pane.

File View Help

[« ] Dashboard Profiles

0.8
oS

Hello, guest!
o free question left
Upgrade to pro and get 3 more questions

Sign in or sign up to continue

Sign Up

Reset password Service terms (i)

CPU: 8 41°C @36% GPU: & 33°C @ 12%

Auslogics ChillMate

Statistics Advanced Tools

Ask a Question

Get professional answers here

Auslogics proudly presents a new unique feature: a

way for you to directly contact our computer experts.

If you have any questions regarding Windows, PC,
installed software or devices, ask uor expert and
receive a comprehensive answer.

Choose a question category:

» Windows questions
» Software questions
» Devise questions

Having problems with Auslogics software?

Ask your question as many times as you need: it's
always free.

Need help? » Go to Support

RAM: @ 36%  NET: @ 612 Kbps  SSD: & 27°C @ 2%

Q¢ -

Latest Question

09.08.2025 HDD 100%

Is there an easy fix to get rid of an HDD 100% issue. Tried
resetting RAM limits.

Read Now

09.08.2025 Free disk space issue

| have two external HD of exactly the same size, 3.63 TB,
they both hace exactly the same amount of data stored
on them both, 1.84 TB, 2240 files, 61 folder...

Read Now

09.08.2025 Indexing keep turning off

Gretting. | noticed that my Auslogics BoostSpeed 11
keeps tirning of my windows search indexing. How can i
prevent that from happening regards...

Read Now

09.08.2025 PC not powering up

After replacing processor 1600 x to 5600 x and
motherboard MSI B350m to ASUS B550m-a, PC won't

Read other qustions

View more

X

..: Ask a Question Auslogics Store |2 [ >




AUSLOGICS CHILLMATE

FEATURES OVERVIEW

Auslogics Store

In this tab, you can learn more about Fle  View  Help 1 Auslogics Chillvate
other Auslogics products and easily
download and purchase them.

Dashboard Profiles Statistics Advanced Tools Ask a Question 5!["” Auslogics Store

Top Seller . |
Clean, tweak and turbo-charge your computer today

BoostSpeed 14

Top-notch protection against malware and data

Anti-Malware safety threats.

Auslog k Defrag Ultimate is the perfect tool to

Disk Defrag Ultimate Z
9 get your d working at maximum effic

SSD Optimizer Safe performance improvement for your SSD drive

Disk Defrag Choice of millions of users w

Registry Cleaner Safe and easy way to restore stability

Download, convert and save any video from the

) Viden Grahher Riv now

CPU: & 42°C @ 10% GPU: & 40°C @ RAM: @& 77%  View more Activate Full Version
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AUSLOGICS CHILLMATE

Settings

Although ChillMate works great with the default settings, it also offers extensive customization options, allowing you to enjoy

a program that looks and works exactly as you want it.

To access ChillMate settings, select

Settings from the File menu or click on
the gear icon at the bottom right of the
main program window.

File View Help

aTs - FTRILY [T
¥& Run Application
B R i S
o Windows Control Panel
O x oy ey ciep, P ca s
g Administration Panel
{2} Settings

@ Check for Updates

Activated:
07:26:35

f . .
“{r Auslogics ChillMate

Profiles Statistics

Game Profile

e Office Profile

Default Profile

QOutdoor Profile

Browser Profile

CPU: & 56°C 3 36%  GPU: 0§ 33°C @ 12%  RAM: 3 30% \View more

Advanced Tools

Ask a Question

Auslogics Store | 2

13th Gen Intel(R) Core(TM) i9-13900K

33°C

vl

Satisfied with the app?

Rate us!

-

| Cwutdo

A

37 %
2 h 35 min time
remaining

or Profile +1h

7%

uslogics store
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AUSLOGICS CHILLMATE

SETTINGS

General

In this tab, you can set the program
to launch at Windows startup and run
in minimized mode, choose whether
clicking X closes the window or
fully exits the program, disable
profile editing, and select whether
temperatures are displayed in Celsius
or Fahrenheit.

Settings

@ General

© Interface

@ Notifications

@ Language

General

Automatically launch at Windows startup
Run the program in minimized mode
Minimize the program to the tray, not close it

Disable profiles editing

Temperature unit:

O Celsius (°0) Fahrenheit (°F)




AUSLOGICS CHILLMATE

SETTINGS

Interface

In this tab, you can adjust the size of
interface text and elements and
select your preferred color mode.

Settings Interface

Size of application interface text and elements:  125% (recommended)

@ General

If you select something other than the recommended value, it may cause application text and elements to be displayed
incorrectly or in low quality.

@ Interface

Interface color scheme:

@ Notifications Light O Dark

@ Language
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AUSLOGICS CHILLMATE

SETTINGS

Notifications

In this tab, you can prompt the
program to show software
recommendations, notify you about
new Auslogics blog posts, and send
you Ask a Question forum updates.

Settings

@ General

© Interface

C’; Notifications

@ Language

Notifications

Show software recommendations
Show new blog post notifications

Enable Ask a Question forum notifications
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AUSLOGICS CHILLMATE

SETTINGS

Language

In this tab, you can select your
preferred language for the program
interface.

Settings

@ General

© Interface

@ Notifications

@ Language

Language

Program interface will be displayed in the language you select here.

Your language (location):

English (United States)

s
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AUSLOGICS CHILLMATE

Registering Auslogics ChillMate

Register your product to unlock full functionality.

ofig

ﬁ
Satisfied with the app? *

Rate us!

Auslogics store

SSD: & 27°C @ 2% View more Activate Full Version «

Register Auslogics ChillMate

Enter your license key:

If you received the license key by e-mail, we recommend copying and pasting it
to avoid typos

» Get a license key
» How to Register

Develo |,‘ d by M ic rOSOﬁ
auslogics Partner

After the purchase, you will receive an email with your license code.

e Click Activate Full Version in the bottom right corner. A pop-up will
prompt you to enter your license key.

e Find the license key in your order confirmation email.

e Copy and paste* it directly into the activation field.

* To copy and paste:

» Highlight the license key by clicking and dragging your mouse over it.
e Right-click on the highlighted key and select Copy.
e Return to Auslogics ChillMate, right-click inside the activation field, and select Paste.

e Once the license code is entered, click Register. You will receive a
confirmation that the application has been successfully activated.


https://www.auslogics.com/en/software/chillmate/purchase/?m=manual_CM1RELEASE25&coupon=ACTUAL15
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AUSLOGICS CHILLMATE

Help and support

Many common questions about Auslogics products are answered in our FAQ section. If you don’t find what you are looking
for, feel free to contact our dedicated customer support team 24/7—we are always happy to help.

support@auslogics.com

m X f (> @ | www.auslogics.com Thank you, lOg!ogére



https://www.auslogics.com/en/support/product/chillmate/
https://www.auslogics.com/en/contact/?department=tech
mailto:support@auslogics.com
https://www.auslogics.com/en/software/chillmate/?utm_source=manual&utm_medium=product_page&utm_campaign=chillmate&m=manual_chillmate_product_page
https://www.linkedin.com/company/auslogics-software-pty-ltd/?utm_source=manual&utm_medium=social_media_chillmate&utm_campaign=linkedin&m=manual_chillmate_social
http://www.x.com/auslogics/?utm_source=manual&utm_medium=social_media_chillmate&utm_campaign=x_com&m=manual_chillmate_social
https://www.facebook.com/Auslogics/?utm_source=manual&utm_medium=social_media_chillmate&utm_campaign=facebook&m=manual_chillmate_social
https://www.youtube.com/user/auslogics/?utm_source=manual&utm_medium=social_media_chillmate&utm_campaign=youtube&m=manual_chillmate_social
https://www.instagram.com/auslogics_official/?utm_source=chillmate_manual&utm_medium=social_media_chillmate&utm_campaign=instagram&m=manual_chillmate_social
https://t.me/auslogics_official/?utm_source=manual&utm_medium=social_media_chillmate&utm_campaign=telegram&m=manual_chillmate_social



